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About This Document

Reference Documents

This reference guide refers to the following documents:

Part Number
A28551-01

A28553-01
A28555-01

Conventions

Document Title

Intel® PRO/Wireless 2011 Access Point Product Reference Guide
Intel® PRO/Wireless 2011 LAN Utilities User Guide

Intel® PRO/Wireless 2011 LAN PC Card Product Reference Guide

Keystrokes are indicated as follows:

ENTER

FUNC, CTRL, C
Press A+B

Hold A+B

identifies a key.
identifies a key sequence. Press and release each key in turn.
press the indicated keys simultaneously.

press and hold the indicated keys while performing or waiting for another
function. Used in combination with another keystroke.

Typeface conventions used include:

<angles>
[brackets]

GUI Screen text

Italics

‘single quotes’

Screen

indicates mandatory parameters in a given syntax.

for command line, indicates available parameters; in configuration files
brackets act as separators for options.

indicates the name of a control in a GUI-based application.

indicates the first time a term is used, a book title, variables, and menu
titles.

indicates the exact setting for a parameter.

indicates monitor screen dialog. Also indicates user input. A screen is
the hardware device on which data appears. A display is data arranged
on a screen.

indicates text shown on a radio terminal screen.
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URL indicates Uniform Resource Locator.

This document uses the following for certain conditions or types of information:

@ Indicates tips or special requirements.

MHata

b Indicates conditions that can cause equipment damage or data loss.

trained personnel should attempt to correct or perform.

EF‘ Indicates a potentially dangerous condition or procedure that only Intel-

Wenrning
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chapter 1 Preparing for an Intel Site Survey

Installing an Intel® PRO/Wireless 2011 LAN begins with conducting a site
survey. A site survey involves using the Site Survey utility to determine the
physical requirements for a site-specific Intel® PRO/Wireless 2011 LAN. A
site survey analyzes the installation environment and provides users with
recommendations for equipment and placement.

Use the Site Survey utility to determine the placement of access points and
antennas, as well as the number of devices necessary to provide optimal
service. The facility can be a warehouse, manufacturing plant, office building
or retail store.

Only the Intel site survey team or other qualified site survey technicians
should use the Intel® PRO/Wireless 2011 LAN Site Survey utility

In the installation of an Intel® PRO/Wireless 2011 LAN, complete radio
coverage could require multiple antennas. If the facility is small, or the
coverage area is free from physical obstructions, one access point and
antenna could be sufficient. However, a dual-antenna access point could be
required to provide additional diversity if performance and signal reception
issues exist.

If unfamiliar with the Intel® PRO/Wireless 2011 LAN infrastructure and the
components that comprise it, refer fo Appendix A “Intel® PRO/Wireless 2011
LAN Overview” for an overview of Intel® PRO/Wireless 2011 LAN
technology.
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Preparing for an Intel Site Survey

1.1

Inspecting the Survey Area

During the planning stages of the site survey, a representative from the site
survey team visits the proposed radio coverage site. As a standard practice in
the site survey consultation, the representative gathers facility drawings and
completes a Site Survey Requirements document and a site survey
questionnaire. The representative documents the wiring used within the
facility (10BaseT, 10Base2, fiber optic) and assesses its applicability to Intel®
PRO/Wireless 2011 LAN components.

Several trial installation areas should be selected. The site survey team
analyzes each proposed installation area to document radio transmission
constraints and to develop preliminary access point placement alternatives to
be tested during the actual site survey. The findings from the initial site
inspection should be documented in a Site Survey Request Form and serve as
the outline of the site survey.

The following variables should also be considered in the site survey
requirements definition:

*  RF systems already in use

* availability of lifts for mounting access points

* location of host system(s)

e available AC power

e interfering metal fire breaks and wall structures

* availability of customer technical personnel o answer questions during
the survey

¢ doorways and passages causing RF propagation.
The completion of the RF Site Survey Requirements document is a

coordinated effort between the site survey team and the customer
management team.
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Preparing for an Intel Site Survey

The RF Site Survey Requirements document does not identify potential
installation constraints within the customer site, nor does it recommend
access point and antenna placement location. The RF Site Survey
Requirements document represents a preliminary overview of the customer
site used as a baseline for refining site survey requirements.

1.1.1  Environmental Radio Coverage Considerations

The site survey team selects trial component installation areas away from
transformers, heavy-duty motors, fluorescent lights, microwave ovens,
refrigerators and other industrial equipment. Areas with excessive moisture,
heat and dust are inappropriate for staging a wireless network.

Signal loss can occur when metal, concrete, walls or floors block access
point fransmission areas. Access point antennas are trial-mounted in open
areas or added to an existing access point to boost the Intel® PRO/Wireless
2011 LAN coverage area.

The positioning of an access point depends on the floor plan of the site.
The site survey team makes access point and antenna placement
recommendations based on the following installation site variables:

* outdoor or indoor installation site
* large or small proposed radio coverage area
* wide or narrow proposed coverage area

* open coverage area or area with documented obstructions.

General Guidelines

Site surveys for direct-sequence spread spectrum devices require
experimentation with different antennas at various angles. Placing a
directional antenna in a vertical position can often minimize multi-path
problems in a direct-sequence environment.
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Preparing for an Intel Site Survey
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In an indoor environment the range at 11 Mbps is about 60 feet, with some
data packets transmitting at 5.5. Mbps. The range at 5.5 Mbps is between
100 - 120 feet, with some data packets transmitting at 2 Mbps. In an open
air environment, the range is between 600 and 1200 feet. These
measurements were obtained with antenna diversity enabled.

Do not locate access points near corners, against walls, against metal walls
or inside plenums.

1.1.2 Channel Interference Considerations

Intel® PRO/Wireless 2011 LAN access points require careful survey area
testing to ensure radio transmissions do not overlap. If necessary, adjacent
access points require omnidirectional and directional antennas to optimize
radio coverage in conflicting coverage areas and neighboring cells with the
same direct-sequence channel.
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1.2 Antenna Placement Considerations

Radio coverage requirements relate directly to installation site constraints.
With an omnidirectional antenna, the radio range of the access point could
have a radius up to 1000 feet (303 meters) in open areas. However, in office
or retail environments, obstructions can reduce the coverage to a radius of
180 to 250 feet (54 to 76 meters). Use a directional antenna for sites that
require longer distances over relatively narrow areas. The coverage area is
also referred to as a cell.

An omnidirectional antenna transmits and receives radio waves

in all directions. The coverage area is circular with the antenna at

the center. Omnidirectional antennas are also referred to as whip or low-
profile antennas.

Directional antennas transmit and receive radio waves off the front of the
antenna. The power behind and to the sides of the antenna is reduced.
The coverage area is oval with the antenna at one of the narrow ends.
Typical directional antenna beam width angles are from 90°,

(somewhat directional), to as little as 20°(very directional). A directional
antenna directs power to concentrate the coverage pattern in a particular
direction. The antenna direction is specified by the angle of the coverage
pattern called the beam width.

The decibel (dB) represents the unit of comparative power for assessing radio
signal strength. For Intel® PRO/Wireless 2011 LAN antennas, addition and
subtraction can calculate total dB loss. The abbreviation dBm is the decibel
referenced to 1 milliwatt (mW).

Mathematically:
dB = 10 LOG Pr where Pr is the power ratio (P1/P2)
when calculated against T mW then:

dBm = 10 LOG P/.00TW
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Preparing for an Intel Site Survey

Example:
P = 2W, then Pr = 2W/.001W = 2000
dBm = 10 x LOG 2000 = 10 x 3.3 = 33
therefore, a 2W transmitter equates to 33 dBm.
To convert dBm back to a power level the inverse function is used that is:
PmW = 10(dBm/10)

For directional antennas, signal strength (gain) can be increased by diverting
power from the non-coverage areas and redirecting it into the area where
coverage is required.

When directional antenna power is concentrated, RF coverage increases
within the beam width. The increase in RF coverage within the beam

width is called antenna gain, and is measured in dB. A good guideline is a
2.5% increase in range for each 1 dB increase in antenna gain for indoor
sites, and a 5% increase in range for each 1 dB increase in antenna

gain for unobstructed outdoor sites. Actual results vary depending on

site obstructions.

Directional antennas are recommended where the coverage area is confined
to an area such as a hallway or corridor. Intel recommends omnidirectional
antennas in areas where the coverage area is in an open area with little
interference.

The final location of access point antennas is critical fo the successful
operation of the system. When conductiong the survey, consider the exact
conditions in the installation area. These conditions include all losses due to
cabling and connectors.
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1.2.1 Diversity Reception

Diversity reception is the use of two antennas attached to a single access
point. A second antenna can improve radio reception. The second antenna is
attached to the AP SECONDARY ANTENNA connector and is used only for
receiving radio signals. The primary antenna is used for both transmitting
and receiving.

The principle behind diversity is to overcome interference or fading by using
the signal with the strongest reception.
1.2.2 Site Electrical Considerations

Intel® PRO/Wireless 2011 LAN access points draw power from wall outlets.
Access point performance is subject to degradation due to inherent or
random electrical problems or site-specific disturbances.

The following access point electrical installation alternatives are listed from
optimal for an installation area to preferred for that area:

1. isolated ground circuit with an online, uninterruptable power supply (UPS)
that also acts as a filter and surge suppressor

2. isolated ground circuit with a surge suppressor
3. dedicated circuit with a UPS

4. dedicated circuit with a surge suppressor

5. nondedicated circuit with a UPS

6. nondedicated circuit with a surge suppressor

Intel recommends items one through four when using a Network Controller
Unit. Deviation from one of these four items can cause data loss and serious
transmissions problems.

Intel does not recommend configuration items five and six due to the nature
of a nondedicated circuit. A nondedicated circuit contains open receptacles
and the load and type of use cannot be predicted at the time

of installation.
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&

[RE1

Ensure the availability of power to an access point 24 hours a day.
Intel recommends access point power never be provided from an Energy
Management System.

If it is necessary to use a nondedicated circuit, Intel recommends that the
circuit not support:

¢ hard wired devices

¢ devices with components intended or known to produce heat such as
space heaters, laser printers, heat guns and soldering irons

* single device drawing more than 20% of the rated value of the circuit

e devices drawing more than 60% of the rated circuit value.

1.3 Requesting an Intel® PRO/Wireless 2011 LAN Site
Survey

Once the customer has been consulted, their needs identified, environmental
antenna requirements considered, site electrical constraints identified and
several trial installation sites selected, a survey team representative
completes the Site Survey Request Form.

The Site Survey Request Form contains detailed information about the
customer, the Intel Sales Associate representing the customer, an updated
floor plan of the customer facility, host operating system considerations and
the quantity and type of components being installed.

The site survey team reviews the Site Survey Request Form to decide whether
to approve the proposed Intel® PRO/Wireless 2011 LAN installation based
on its likelihood to succeed. Once the Site Survey Request Form is generated,
customer final approval is required before formally scheduling the site
survey.
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1.3.1  Scheduling the Site Survey

The site survey is scheduled as soon as the site survey team and the customer
approve the Site Survey Request.
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Using the Site Survey Utility to Conduct a Site Survey

Chapter 2 Using the Site SUI'VQY U'l'ili'l'y to
Conduct a Site Survey

Use the Intel® PRO/Wireless 2011 LAN Site Survey utility to establish a two-
way data network using both stationary and mobile devices at various points
within the proposed radio coverage area. Assess AP signal strength using
various antenna and AP configurations to determine areas requiring
additional or higher performance antennas.

|
L

The Intel® PRO/Wireless 2011 LAN Site Survey utility runs under Windows
95/98, NT and 2000.

Site Survey Administrators Guide
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Using the Site Survey Utility to Conduct a Site Survey

2.1

2.1.1

Installing the Intel® PRO/Wireless 2011 LAN Site
Survey Utility

A Site Survey requires the site survey utility be loaded on the mobile devices
and the desktop computer used in the survey.

Installing the Site Survey Utility from a CDROM
To install the Intel® PRO/Wireless 2011 LAN Site Survey utility from CDROM:

1.
2.
3.

Insert the installation CDROM in the computer CD drive.

Click Start and select Run.

Enter x:\Setup.exe

where x represents the letter assigned to the CD drive.

Click OK.

Complete the installation following the instructions provided with the
Intel® PRO/Wireless 2011 LAN Site Survey utility.

Select Yes when asked if backup copies of replaced files are required.

Selecting Yes invokes the site survey utility uninstall feature for
possible use.

The Intel® PRO/Wireless 2011 LAN Site Survey utility installation is
completed. Launch the site survey utility by clicking on the program icon
appearing on the Windows desktop.

2.1.2 Copying the Site Survey Utility from the Intel Web Site to a
Desktop Computer

To copy the Site Survey utility from the Intel Web site:

1.

From a desktop computer, go to the Intel Web site
(http://support.intel.com) and select the Intel® PRO/Wireless 2011 LAN
Site Survey utility.

A File Download window appears prompting the user to run the utility
from its current location or save it to disk.
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Using the Site Survey Utility to Conduct a Site Survey

2. Check the Save this program to disk option and click OK.

A Save As window appears prompting the user to enter the destination
for the Intel® PRO/Wireless 2011 LAN Site Survey Utility.

Select the drive letter assigned to the desktop computer hard drive and
click Save.

The zipped Site Survey utility files copy to the desktop computer hard
drive.

Extract the Site Survey utility by double-clicking the Intel® PRO/Wireless
2011 LAN Site Survey utility icon and completing the instructions
provided by the program.

Once the utility has been extracted to the desktop computer the utility
installation is complete.

2.2 Creating a Trial Intel® PRO/Wireless 2011 LAN

Before using the Site Survey utility, an Intel® PRO/Wireless 2011 LAN wireless
LAN infrastructure is created to test component radio signal strength.

In addition to the Site Survey utility, the following equipment is required to
create an Intel® PRO/Wireless 2011 LAN:

access points

digital camera

distance measurement wheel

directional and omnidirectional antennas
MUs with extra batteries

Access point battery.

To install a trial Intel® PRO/Wireless 2011 LAN:

1.

Connect the access point antenna(s).

2. Mount the access points.
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Using the Site Survey Utility to Conduct a Site Survey

Mount access points at the locations recommended on the floor plan
drawing. Start with the most difficult coverage area first. Position the
access points so the antennas are not obstructed.

3. Power on the access points.
Use battery power if an AC wall socket is not convenient.
4. Observe access point LED behavior.

Observe the LEDs to verify normal boot operation. After the boot cycle is
complete, the STATUS LED flashes approximately once every second to
indicate the access point is operating properly.

el Component installations differ depending on the device installed. Refer to
the documentation shipped with each component to ensure proper
installation and configuration.

5. Power on the MUs used for the site survey.

e The Site Survey utility should already be loaded on the mobile devices and
desktop computer used to perform the survey.

When the device is powered on it displays a message indicating the
access point is not connected to a boot server. This is normal since the
access point is not yet connected to an Ethernet network.

6. Set the access point and MU Network IDs.

Set the MU(s) and access point to the same Net ID. Normally, the access
point default value 101 is used.

An Intel® PRO/Wireless 2011 LAN now exists and can be tested for radio
transmission effectiveness with the Site Survey utility.
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Using the Site Survey Utility to Conduct a Site Survey

2.3 Starting the Intel® PRO/Wireless 2011 LAN Site
Survey Utility
To launch the Site Survey utility:
1. Click Start and select Programs.
2. Click Intel Wireless LAN and select Site Survey.
3. Click Site Survey and select Site Survey again.

The Site Survey utility Welcome dialog box displays.

Use the Welcome dialog box to open an existing site survey area workspace,
create a new workspace, create a new workspace from an existing site survey
area workspace (a template or a .sst file) or open a recently used workspace.

Wwieloome to Site Survey.

Thiz wirelezs LAM utility allows pou to survey the wireless landscape and
determing the bezt location for vour network, access points.

% [pen an existing workspace

" Create a new workspace

" Create new workpace from a temnplate =

' Dpen a recently used workspace _
REcent Site Surveys: IBaseLine.ssw j Help |

If an existing site survey workspace is opened containing one or more survey
areas, the Site Survey Test dialog box displays. Use the Site Survey Test
dialog box to specify the ICMP test parameters for the survey area. If an
existing survey workspace does not have a survey area defined, the Site
Survey dialog box displays. Use the Site Survey dialog box for entering

the site survey area name, surveyor and description. The Site Survey Test
and Site Survey dialog boxes are described in greater detail in the sections
that follow.
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Using the Site Survey Utility to Conduct a Site Survey

Closing the Welcome dialog box enables the File, Edit, View, Area and
Help pull-down menus. Use these menus to create a new site survey, view
radio coverage areas within an existing site survey template, run a ping test
for a survey areaq, display and configure the Edit menu property pages and
display help information for the usage of the utility.
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Using the Site Survey Utility to Conduct a Site Survey

2.4 Navigating the Site Survey Utility File Menu

Use the File menu to create a new survey area workspace, open an existing
survey workspace, define a new survey area, save the survey workspace,
work with a report, import survey workspace data and display recent
survey information.

M ew Site Surey... Chrl+
Open Site Survey... Ctrl+0
MHew bArea... Chrl,

Sawve Sike Survey Clrl+5
Save Site Survey Az

|rpart... Chrl+l

Open Repoit. ..

Save Report

Save Report &z,

Errirt... Ctrl+P
Frint Prexiew

Frint Setup...

Recent Site Survey Files »

Exit
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2.4.1

2.4.2

Creating a New Site Survey

Select New Site Survey from the File menu or click on the application
toolbar button resembling a sheet of paper to open a Site Survey dialog
box. Use the Site Survey dialog box to enter the site name, surveyor and
description. If a workspace is open, the user is prompted to save the existing
workspace first. Click OK to save the new workspace information. The status
bar at the bottom of the screen displays the new workspace name.

Site Survey E3

Drate: IEUH;"SS "I

Site Mame: IDepartment Store

Surveyor: I.John Do

Dezcrphion:  |Single struchure
100,000 zq. f.
Adjacent warshouse]

=
] 3 | Help

|

Selecting an Existing Site Survey

Select Open Site Survey from the File menu to open a standard Windows
dialog box displaying files with the extension.ssw. If an invalid file is read,
an error message displays, otherwise, a progress dialog box displays and
the workspace is loaded. The Site Survey Test dialog box displays if the
workspace has at least one defined area. The Site Survey Area dialog box
displays if the existing workspace does not have a defined area. The status
bar displays the workspace and area name.
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2.4.3 Defining a New Site Survey Area

Select New Area from the File menu to display a Site Survey Area dialog
box. Use the Site Survey Area dialog box to enter the area name and
description. The Delete button is grayed when defining a survey area. The
Test Name field lists the tests defined for that area. Add a new test by clicking
the ellipsis (...) button. An error message displays if the Area Name field is
left blank or the name of an existing area is entered. The area name displays
at the bottom of the screen.

Site Survey Area |

Brea Mame: I***PP"EIHCEDEF'L Test Mamne: |1|:|Dpingtest 'l |

Dezcription: {20 000 sq. ft. ;I

4 zteel pillarz dividing dept. 0K

===

-
ol F Help

dil

2.4.4 Save/Save As

Select Save from the File menu or click on the application toolbar
resembling a diskette to save the open workspace using the existing

survey name. Select Save As from the File menu to save the survey using a
different name.
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2.4.5 Importing a Site Survey

Select Import from the File menu to display an Import Areas and Tests
dialog box. Use the Import Areas and Tests dialog box to import survey
areas and/or tests from another survey workspace. Select Import Areas and/
or Import Tests to replace existing survey areas and tests or to add new ones.
Click the Import button to display a standard Windows dialog box displaying
files with the extension .ssw.

Import Areaz and Tests E

—Area Options
W Import &reas

¥ Eeplace duplicate areas of the same name.

— Test Options
V¥ Import Tests

V¥ Replace duplicate tests of the zame name.

Impart... Help

2.4.6 Working With Reports

A Site Survey Report can be generated, edited and printed for each site
survey workspace. The Site Survey Report is a WordPad document
generated when the survey is complete. The report can be edited as a typical
WordPad document. The template for a new report has the filename Site
Survey Results.doc and is installed in the same directory as the program
executable.
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2.4.7 Displaying Recent Site Surveys

Select Recent Site Surveys from the File menu to display the last four site
survey workspace files created or accessed. Selecting any workspace in the
list loads that workspace. If there is at least one Area defined for the
workspace, the Site Survey Test dialog box displays. The status bar at the
bottom of the dialog box displays the status, filename, area name, and
workspace name. If a workspace is already open, the user is prompted to
save the existing workspace first.

2.5 Navigating the Edit Menu

The Site Survey Edit menu contains Site Survey, Area and Default Settings
pull-down menus. It also contains items for WordPad editing.

YWiew Area Help

Site Survey...

Area...

Default Settings...

rde ) o
Cut Chrl+
Copy Chrl+C
Pazte Chrl+h
Pazte Special. ..

Select Al Chrl+a,
Find... Ctrl+F
Rl L= =
Replace Ctrl+H
Inzert Mew Object. ..

Lz

et Eroperties &lEERter
| | =l
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Use these menu items to edit an open Intel® PRO/Wireless 2011 LAN site
survey, display a list of coverage areas within the workspace and use the
Setup, Meter Settings, Sounds and Logging property pages to configure
surveyor, system sounds and test data logging information. Use the menu
items below Default Settings to edit the report file.

2.5.1 Editing Existing Site Survey Information

Select Site Survey from the Edit menu or select the application toolbar button
resembling an open folder to display the Site Survey dialog box. Use the Site
Survey dialog box to enter the site name, surveyor, and description. If a
workspace is already open, the user is prompted to save the existing
workspace. Click OK to save the edited workspace information.

D ate: I 9/13/99 VI

Site Mame: IDepartment Store

Surveyor: IJ ohn Doe

Deszcrphion:  [Single structure
100,000 sq. f.
Adjacent warehouse]

=
-
1 F Help

di
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2.5.2 Editing the Properties of an Existing Site Survey Area

Select Area from the Edit menu to display the Site Survey Area List dialog
box. Use the Site Survey Area List dialog box to display a list and description
of survey areas. Select an area and click Edit Area to display the Site Survey
Area dialog box. Add new tests and survey area descriptions as needed.
Click OK to save the changes to the site survey workspace. Click Delete to
remove the area from the current site survey workspace.

Site Survey Area List

Area Mame: Dezcription:

[1ept,
nce Dept.
WWiamen's Dept.
Children's Dept.
Toy Dept.
Furniture Dept.

10,000 sq. ft. ar=a Edit Area...

il

Site Survey Area E

Birea M arme:; Il’:"-II'I:'“ElﬂCEDBIJl- Test Mame; I'IEIEIpingtest "I |

Deserption: {20,000 5q. ft. ﬂ

|4 steel pillars dividing dept. K

efete

ﬂ 3 | Help

FLE
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2.5.3 Editing the Default Settings Property Pages

Select Default Settings from the Edit menu or click on the application
toolbar resembling a hand pointing to a card to access the Setup, Meter
Settings, Sounds and Logging property pages. Use these property pages to
change default settings for the current site survey workspace.

Setup Property Page

Select the Setup property page to change the following default site survey
workspace information:

Surveyor. Enter the surveyor name in the Surveyor field to automatically
update the New Site Survey dialog box. Click OK to save the updated
surveyor name in the registry for subsequent surveys.

Auto Rerun. Run the Site Survey utility in either automatic or manual mode.
If Auto Rerun is checked, the test suite runs for the rerun count or until the
surveyor stops the tests.

Site Survey Settings

Setup IMeterSettingsl Soundsl Lu:uggingl

Survepor; ICMP Hozt Addr: I 187 0235 . 93 . 34

Ping Count: 100 Rerun Count: a0
Facket Size: 122 Threzhald [ms): |3500
[ &wuto Remn [ Overmide All Test ICWMP Host Addreszes

OF. I Cancel | AEp | Help |

ICMP Host Addr. Enter an ICMP Host Adrress in the field provided.
The default address is the default address of the AP
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& If a pre 4.0 version of Internet Explorer is running on a Windows 95 (Rev B)
Plata system, the Setup Property Page does not display. Update Internet Explorer to
version 4.0 or greater to resolve this problem.

Ping Count. Enter the number of pings to be transmitted during the ping
test in the Ping Count field. The default Ping Count is 100, with a maximum
of 2000.

Rerun Count. Enter the number of times the ping test is fransmitted
in the Rerun Count field. The default Rerun Count is 100. The rerun can
be Continuous.

Packet Size. Enter the packet size transmitted during the ping test in the
Packet Size field. The default Packet Size is 128 bytes, with a maximum of
1472 bytes.

Threshold Time. Enter the maximum acceptable time to send out and
receive the total number of pings for each test in the Threshold field. Choose
a Threshold Time from1 milli-second to 100,000 milli-seconds. The default
Threshold Time for 100 pings is 3500 milli-seconds.

Override All Test ICMP Host Addresses. Check this box to use the ICMP
host address entered on this page for all tests. Checking this box does not
replace the host address saved for each test.
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Meter Settings Property Page

Select the Meter Settings property page to set bounds (thresholds) for the
signal quality gradient bars in the Round Trip, Missed Beacon and Transmit
Retry fields. The circular RTT Avg, Missed % and Retry % indicators on the
Site Survey Test dialog box show green if the average of the previous tests
(20 tests for RTT Avg, 40 tests for Retry % and 20 tests for Missed %) is below
the lower threshold.

The circular indicators on the Site Survey Test dialog box show red if the
average of the previous tests is above the upper threshold. Test results
between the bounds set on the Meter Settings property page result in yellow
displays on the circular indicators on the Site Survey Test dialog box. The
circular indicators show green if the test results are below the lower bounds.

Site Survey Settings [ <

Setup  Meter Settings |Snunds| Loggingl

—Round Trip Bounds [mg]

Green Light Below: IE Red Light Above: a0 [mniz]

r— Mizzed Beacon Bounds [percent]

Green Light Below: I‘l':I Red Light Abowe: 30 [%]

r— Tranzmit Rety Bounds [percent)

Green Light Below: |30 Fied Light Above: (45 (%)
Ok I Cancel | Sl | Help
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Sounds Property Page

Select the Sounds property page to change the following default site survey
workspace information:

Play on Timeout. Select Play on Timeout to emit an audible timeout tone
every time a ping test timeout is reached.

Play on Roam. Select Play on Roam to emit an audible roaming tone every
time an MU roams between APs.

Site Survey Settings

Setup I Meter Seftings  Sounds |Lugging|

Sound Settings
¥ Play on Roam

¥ Play on Threzhold ¥ Play on Test Complete

OF. I Cancel | Spply | Help |

Play on Threshold. Select Play on Threshold to emit an audible threshold
tone every time the threshold time is met or exceeded.

Play on Test Complete. Select Play on Test Complete to emit an audible test
complete tone every time a suite of ping tests has been transmitted.

The default for the Sounds property page is all four sounds enabled. Set the
volume level and/or sound by using the standard Windows Control Panel
Volume and Sounds applet or the Sounds task tray applet.
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Logging Property Page

Select the Logging property page to change the following default site survey
workspace information:

Enable Logging. If unchecked, no logging takes place during the ping fests.
The logfile consists of the date, time, and test settings (area name, test name,
packet size, rerun count and signal quality boundaries). System messages
and notes (if any) are also added to the logfile. If the user has chosen to
record real-time test noise data and/or data points, they are also added to
the logfile.

Site Survey Settings [ x|

Setup I Meter Settingsl Sounds Logging |

W Enable Logging

¥ Clear Log contents before each test

¥ Canfim before log cortents are cleared

k. I Cancel | ol I Help |

Clear Log contents before each test. Select Clear Log contents before each
test to automatically clear the content of the log before a test suite is run.

Confirm before log contents are cleared. If checked, the surveyor is
prompted whether the logfile should be cleared before the test suite is run.
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2.6 Navigating the View Menu

The Site Survey utility View menu contains Adapter Info, Areas, Known APs,
Noise Meter, Signal Quality and Generate Report pull-down menu items.

Area  Help

Adapter Info...
Areas...

Krnown AP's, .
Moize Meter.
Signal Buality...
Generate Report

v Toolbar
v Status Bar

Use the menu items to view WLAN adapter driver and Firmware data, site
survey areas, access points within range of a target mobile device and a
graph depicting MU signal quality and to append the logfile to the report file.
The status bar at the bottom of the main window can be displayed or hidden
by checking or unchecking Status Bar. The tool bar buttons can be displayed
or hidden by checking or unchecking Toolbar.
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2.6.1 Viewing Adapter Info
Select Adapter Info from the View menu to display an Adapter Information
dialog box. Use the Adapter Information dialog box to display WLAN
adapter driver and Firmware version, adapter type and Firmware type,
supported data rates and ESSID. The information is view only and cannot be
modified.
Adapter Information
Driver Version: 4.1 Firmweare Type:  [EEE 80211
Adapber Supparted _
Firmware Yersion: 338 330315 Data Rates: THEit Only
Adapter Type:  PCMCIA ESSID: 101
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2.6.2 Viewing Site Survey Area Info

Select Areas from the View menu to display the Site Survey Area List dialog
box. Use the Site Survey Area List dialog box to display a list and description
of survey areas. Select an area and click Edit Area to display the Site Survey
Area dialog box. Add new tests and survey area descriptions as needed.
Click OK to save the changes to the site survey workspace. Click Delete to
remove the area from the current site survey workspace.

Site Survey Area List |

Area Mame: Dezcription:

‘Men's Dept 10,000 2q. ft. area Edit &rea... |
Appliance Dept. —

“Wiomen's Dept.
Children's Dept.
Tay Dept.
Furniture Dept.

Site Survey Area E

trea Mame: I.ﬂ.pplianceDept. Test Mame: I'IEIEIpingtesl 'l |

Description: (20,000 sq, ft ﬂ

4 steel pillars dividing dept. 0K

nelete

4] H Help

dil;
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2.6.3 Viewing Access Point Info

Select Known AP’s from the View menu to display the recognized access
points in range of the target MU. Use the Known AP’s dialog box to view the
access point BSS ID, number of associated MUs, MU type and status and
data rate. An icon next to each access point indicates whether the access
point is mandatory or preferred and whether or not the access point is
associated. A list of access points within range of the MU is also shown.
Select an AP and right click to change the AP type to Mandatory or Roaming.
Click the Rates button to display the Transmission Rates dialog box. Use the
Transmission Rates dialog box to set the transmission rate to 1 Mbit, 2 Mbit,
5.5 Mbit or 11 Mbit. Checking multiple rates defaults the MU to a lower rate
if the higher rate AP association cannot be established. If no rate is checked,
the transmission rate is that of the wireless LAN adapter.

The Rates button is only enabled in frequency-hopping systems. It is not
available in direct-sequence systems.

Known Access Points Ed

| BSSID | #of MUz [ Type / Status | KBit per/sec
Fﬁ 00:ALFE:7B:95: 76 2 t andatory £ Azzociated 1]

d |

Murber of Known Access Points: 1 Refresh

ESSID |35 Rates...

4l

Help
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Tranzmizzion Bates E |

v 1 MBit [ 55 HER

................

W 2 MEit = HET

Apply |
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2.6.4 Viewing Mobile Unit Noise Info

Select Noise Meter from the View menu or click the application toolbar
button resembling a colored bar graph. One of two graphs display
depending on the type of network equipment being used.

Frequency-Hopping Spread Spectrum

In a frequency-hopping spread spectrum network a graph of Relative Signal
Strength Indicator (RSSI) values and channel numbers displays. Use the
Noise Meter dialog box to view the MU BSS ID and the RSSI minimum,
maximum and average values. The RSSI values displayed in the graph are
continuously updated with the last six received values displayed in blue. Click
Reset to reset the graph to zero and click Go to begin a new display as RSSI
values are received. Check Record Real Time Data to append RSSI values to
the logfile.

—r——
£% Noize Meter

Min: 26

—_— MU Relative Signal Strength Indicator
R551 Walue g g baw 40

O0:A0:FS:27:B2:55

Avg 39

1282
ol
G4
32

u]
u] 10 20 30 40 a0 [=iu] el Ta

Channels

¥ Record Real Time Data Reset |
Help |
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Direct-Sequence Spread Spectrum

In a direct-sequence spread spectrum network two graphs can display. For
adapter version 1.0 a graph illustrating channel quality, average signal level
and average noise level displays. The channel quality ranges from 0 to 31
and is calculated as the difference between the average signal level and the
average noise level. These levels are averages calculated over time. The
channel quality minimum, maximum and average values are displayed and
the graph is continuously updated. Click Reset to reset the graph to zero.
Click Go to begin a new display as channel quality values are received.
Check Record Real Time Data to append channel quality values to the
logfile. For adapter version 2.0 or above, only the average signal level
displays. The scale remains 0 to 31.

.'.:'. Motz M-uken ]
[Comumen] hamas st i e
25 Charvaal Duaitly lndicris:
Al &l FHFF FF EA Hh 31

———
£% Noise Meter

Mim: 31

I—A\rerage Signal Level I MU Signal Lewel Indicator Max 11
00:AD:FE:12:59:91 :

L |

Average Signal Level

Stop |

Reset

Help

dd
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2.6.5 Viewing Mobile Unit Signal Quality Info

Select Signal Quality from the View menu to display the real-time
percentage of missed beacons, the percentage of transmission retries and
the percentage of CRC errors. Use the Signal Quality dialog box to display
the strength of the radio signal transmitted by an access point. This
information is useful in determining if the trial site survey access point
placement locations are effective for providing radio coverage to the
proposed radio coverage area.

Signal Quality E

— Signal Quality Information
00 A AR A A A AR E A
o
E 50 =
u}
Perzent Mizzed Beacons: 1]
Percent Tranzmit B etries: 1]
Percent Received CRC Errars: 1]
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2.6.6 Generating the Site Survey Report

An Intel® PRO/Wireless 2011 LAN Site Survey Report can be generated for
each site survey workspace. The report contains an overview of the survey,
installation considerations, warranty information, survey findings, equipment
placement recommendations and a detailed results section.

The report is a Microsoft WordPad document that can be generated when the
survey is complete. The report can be edited and printed using the Cut,
Copy, Paste and Print application toolbar buttons. The template for a new
report has a Site Survey Results.doc filename and is installed in the same
directory as the program executable.
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2.7 Navigating the Area Menu

The Site Survey utility Area menu contains New, Select, Clear Log Contents,
Edit Note and Run ICMP Test and Run Throughput Test menu items.

Help

Mew...

Select...

Clear Log Contents
Edit Mate...

Run [CMP Test..
e BN st
Run Throughput Tests. .

Use the menu items fo create or edit a site survey area, view the settings of a
survey area, clear a site survey log, add notes to the survey log, run ICMP
tests and run throughput (FTP) tests.

38 Site Survey Administrators Guide



Using the Site Survey Utility to Conduct a Site Survey

2.7.1  Creating a New Survey Area

Select New from the Area menu to display a Site Survey Area dialog box.
Use the Site Survey dialog box for entering a survey area name and
description. If a workspace is already open, the user is prompted to save
the existing workspace. Click OK to add the area to the workspace.

Site Survey Area E
drea Mame: I.ﬁ.ppliance Dept. Test Mame: |1DEI ping best "I |

4 steel pillars dividing dept.

[efete |

" o |

Deserption: {20,000 sq. ft ﬂ
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2.7.2 Selecting and Editing an Existing Survey Area

Click Select from the Area menu to display the Site Survey Area List dialog
box. Use the Site Survey Area List dialog box to display a list and description
of survey areas. Select an area and click Edit Area to display the Site Survey
Area dialog box. Add new tests and survey area descriptions as needed.
Click OK to save the changes to the site survey workspace. Click Delete to
remove the area from the current site survey workspace.

Site Survey Area List |

Area Mame: Drezcription:

iMe O 10,000 =q. k. area Edit &rea... |
Appliance Dept. —

Wiomen's Dept.
Childrer's Diept.
Taoy Dept.
Furniture Dept.

Site Survey Area |

Area Mame; I.-’-'-.ppliance Dept. Test M ame: |1EIEI|:|ingtest "I |

Description: (20,000 sq. ft ﬂ

I4 steel pillars dividing dept. 0K

Welete

i o e

dil;
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2.7.3 Clearing the Text File Log for an Open Survey Area

Use the Clear Log Contents option to delete the log contents for the active

survey workspace.

2.7.4

Editing the Note File for an Open Survey Area

Select Edit Note from the Area menu to display the Note Editing
dialog box. Use the Edit Note option to add notes to the logfile of the active

survey workspace.

2.7.5 Running ICMP Tests

Select Run ICMP Test from the Area menu or select the ICMP toolbar button
to display the Site Survey Test dialog box.

Site Survey Test

Aecess Paint: 00:AQ:FB:7B:95: 76 | Ping# | Emor | Missed.. | RTT | Retries =
- 100 1] 1] 10 12
bea |trea il o o n 12
Test  |[Stock 512 S e ak 0 12
. a7 1] il 10 12
— Test Statistics 95 ok o 10 12
Tatal Round Trip Time [ms]: 1163 95 ok 1] 10 "
Total Elapsed Test Time [zec]. 977 04 ok i} 10 11
Teszts Remaining In Run: 1] 33 gk o 10 "
Test Runs Remaining: 0 312 SE g :Ilg 13 -
Tranzmit Data Bate: 2 MBit 1] | »
Packets Transmitted: 200 .
Packets Recaived: 101 Percent of Thieshold:  77% Clear List |
Mumber of Retries: 12 l—m—
RS5I: Min: B0  Max B2  Awvg BB
Arevs | © mmry
Mizzed X
| O Start Test I Pause Test |
Retry &
| O Help |

Use the Site Survey Test dialog box to specify ICMP test parameters. ICMP
tests are ping fests assessing radio fransmission roundtrip, delay time and
transmission signal strength. Click Start Test to begin the test.
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Setting ICMP Test Parameters

Use the Site Survey Test dialog box to set the following ICMP test
parameters:

Access Point. The Access Point field of the Site Survey Test dialog box lists
the associated access point. Choose a different access point from the list of
available access points by clicking the ellipsis button.

Area. Define a new survey area by selecting “(New)” from within the Area
pull-down list and clicking the ellipsis button.

Test. Use the Test pull-down list to display the tests defined for the
workspace. Use the ellipsis button to enter new test settings or edit existing
test settings.

Test Statistics. Use the Test Statistics field of the Site Survey Test dialog box
to view the total roundtrip ping time, elapsed test time, tests remaining in the
run, the number of test runs remaining, the transmit data rate, packets
transmitted, packets received and the number of retries. A graph of RSSI (for
frequency-hopping) or average signal level (for direct-sequence) displays.

Four graphs on the bottom of the Site Survey Test dialog box display an
average roundtrip time, missed beacon percentage, retry percentage, and
threshold percentage. Bounds (thresholds) set in the Meter Settings property
page establish the limits for the variables in the graphs.

Results List Box. Use the Results List Box to view ping count, errors,
cumulative retries, roundtrip time and missed beacons percentage. Scroll
backward or forward in the list. The list box holds 1000 pings.

Start Test. Click Start Test to begin the ICMP test. Once started, the Start Test
button changes to a Stop button.

Edit Note. Click Edit Note to display a dialog box for entering notes for the
test. Each note is added to the logfile.

Clear List. Use the Clear List button in Site Survey Test dialog box to clear
the results list box.
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Test Totals. Click the Test Totals button to display the Site Survey Totals
dialog box._

Site Survey Totals

Time Tests Stated:  17:12:528M  Time Tests Ended: 17:12:058M

Total Mumber of Tests Run: 100 out of 100

Total Mumber of Re-Runs: 0 out of 0

Tatal Roundtrip Time: 578 mzecs.

Average Roundtrip Time: B msecs.

Total Mumber of Timeouts: a

Packet Throughput Information

Packetz Tw @ 1 MBIt a Packets T« = 5.5 MBI an
FPacketz Tw @ 2 MBiL: 3 Packetz Tw 2 11 MEiL: 17
Packets Ay @1 MBI a Packets Rx & 5.5 MEit 0
Packets Ay @ 2 MBI a Packets Rx @ 11 MEit: 100
Completion Status: Test Fiun to Completion.

Use the Site Survey Totals dialog box to display the time the tests were
started and stopped, the number of tests run, number of re-runs, total
roundtrip time, average roundtrip time, total number of timeouts and

the test completion status. Packet throughput information is summarized as
the number of packets sent and received and the data rates for each. These
values are recorded in the logdfile if logging is enabled.

Progress Bars. Use the gradient progress bars to view RTT Avg, Missed %,
Retry % and the percent of threshold achieved during the test. The numerical
value is displayed in white in the middle of each progress bar. The bars
change color as the values approach the lower and upper bounds. Green
indicates a value below the lower bound, yellow indicates a value between
the bounds and red indicates a value greater than the upper bound.

Percent of Threshold. The percent of threshold (established in the Setup
property page) that the sum of the round-trip times are approaching.

The white number in the middle of the progress bar is the sum of the round-
trip times.
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Setting New Test Parameters

Select “(New)” from the Test pull-down list box in the Site Survey Test dialog
box. Open the New Test Settings dialog box by clicking the ellipsis button
(..) next to the Test pull-down list box.

Hew Test Settings

Test Mame: |1 00 ping test Fing Caunt; 100

Host Address: I 157,235 .115.114 Packet Size; 128

Ferun Count; |1 oo Threshold [mz): |35':":|

Cptions

¥ Auto Berun

W Sounds ] 4 I Delete |
¥ Logging Advanced... | Help |

Use the New Test Settings dialog box to enter a test name, define test packet
sizes, select a test ping count, enable the test Auto Rerun, Sounds and
Logging features, change host address information and display the Settings

property pages.
Test Name. Use the Test Name field in the New Test Settings dialog box to

enter the test for the active survey area.

Packet Size. Use the Packet Size field in the New Test Settings dialog box
to enter a packet size for the ICMP test.

Ping Count. Use the Ping Count field in the New Test Settings dialog box to
type in a ping count value for the ICMP test.

Threshold. Use the Threshold field in the New Test Settings dialog box to
type in threshold value (in milli-seconds) for the ICMP test. This is the total
round-trip ping transmission threshold.
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Host Address. The host address entered in the Settings Setup property
page displays in the Host Address field. Change the host address value by
typing it in.

Auto Rerun. Select the Auto Rerun option in the New Test Settings dialog
box to enable the Auto Rerun test feature.

Enable Sounds. Select the Enable Sounds option in the New Test Settings
dialog box to enable the Sounds feature.

Logging. Select the Logging option in the New Test Settings dialog box to
enable the Logging feature.

Advanced. Click the Advanced button in the New Test Settings dialog box
to access the Advanced Test Settings property pages for the active survey
area workspace. Use the Settings property pages (Meter Settings,

Sounds and Logging) to change the default settings for the current site
survey workspace.
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2.7.6 Running Throughput Tests

Select Run Throughput Tests from the Area menu or select the FTP toolbar

button to display the FTP Test dialog box.

5% FTP Test

—FTP Server Information

FTP Site Name:

[zer HEme; I

s en Fasawond: I

V¥ Anonymous login

— File Tranzfer Information

* Get file from Site " Put file to Site

¥ Log Results

Get / Put Filenarme: IflpTest.pch

Drefault Site Directon: I

FTF run count: |10

&

¥ Omit LowsAHighs from Transfer Bate Average
— Test Results
Operations: I} Rate High: 0 BytesiSec
Total Bytes: i} Fate Low: 0 Bytes!Sec.
Rate Average: 0O K/Sec. Rate Average: 0 Bytez/Sec.
Help | Cloze |

Use the FTP Test dialog box to specify throughput test parameters.
Throughput tests are File Transfer Protocol (FTP) tests.

Setting Throughput Test Parameters

Use the FTP Test dialog box to set the following test parameters:

FTP Site Name. Use the FTP Site Name field to enter the IP address or site
name of the FTP site.

Anonymous Login. Check the Anonymous Login checkbox to login without
a username or password.
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User Name. Enter the user name for the FTP site.
User Password. Enter the password for the FTP site.

Get file from Site. Select the Get file from Site radio button if the file
specified in the Get/Put Filename field is to be transferred from the site.

Put file to Site. Select the Put file to Site radio button if the FTP file is to be
transferred to the site.

Log Results. Check the Log Results checkbox if the FTP test results are to be
written to the logfile.

Get/Put Filename. Enter the path and filename of the FTP file. The ellipsis
button next to the edit box is enabled when Put file to site is selected. Click
the ellipsis button to navigate to a file.

Default Site Directory. Select Default Site Directory to optionally specify a
subdirectory on the FTP server.

FTP Run Count. The FTP run count is the number of times to transfer
the FTP file.

Omit Lows/Highs from Transfer Average. Check this box to eliminate
outliers from being used in the Transfer Rate Average calculation. Outliers
are those transmit times lower or higher than the current shortest or longest
transmit time.

Test Results. Use the Test Results section of the FTP Test dialog box to view
the number of Operations, Total Bytes, Rate Average (K/Sec), Rate High, Rate
Low and Rate Average (Bytes/Sec).

Click Start to begin the throughput test.
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chapter 3 Conducting a Size Specific Site
Survey

Site surveys differ depending on the size of the survey site. Smaller sites are
surveyed for one or two access points to provide coverage over a space no
larger than a single room. Medium sized sites could require between 10 and
20 access points and be the size of a wharehouse or several rooms. Large
sites could require between 20 and 100 access points and be a large
building with different radio coverage service areas in different parts of the
building.

3.1 Conducting a Survey for a Small Area

To conduct a survey in a site where 1 or 2 access points are anticipated:

1.

Consult with the designated customer contact person.

Discuss any special installation requirements. Determine the type of
cables to be connected to the access points (10 Base T, 10 Base 2, fiber
optic).

Document the size and layout of coverage area.

Document RF systems already in use, location of host system, and
available AC power.

Set up an access point in the middle of the room or where it is estimated
that the coverage cell will be the largest.

Walk the perimeter of the coverage area and measure radio coverage.

For an 11 Mbit direct-sequence network, study round-trip ping times and
data rates. The individual round-trip ping time is usually about 7 ms
before the rate changes from 11 Mbits to 5.5 Mbits (using a packet size
of 1024 bytes). Another set of statistics is obtained by clicking the Test
Totals button. The Totals dialog displays the number of packets
transmitted and received and the rates for each. Move the terminal in
different directions. Position the terminal between the surveyor and the
access point. Do not walk fast or coverage area dead spot could be
missed.
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&

3.2

Depending on the coverage requirements, the perimeter for each of the data
rates might have to be determined separately. For an FH network, run 100

pings with a packet size of 512 bytes. Total test time for 1 Mbit should be
less than 13 seconds; 12 seconds for 2 Mbit.

5. Mark the location of access points on the blueprint, move the access

point to the second survey location and repeat the procedure.
Consult with customer technical personnel.

Infrastructure backbone, hubs and patch panels should all be
documented . Document the conditions existing in the final installation.

Complete the Site Survey Report.

The report indicates the number and location of the access points. Assign
the access points the same channel for each coverage area.

Conducting a Survey for a Medium Sized Area

To conduct a survey in a site where 10 - 20 access points are anticipated:

1.

Consult with the designated customer contact person.

Discuss any special installation requirements. Determine the type of
cables to be connected to the access points (10 Base T, 10 Base 2, fiber
optic).

Document the size and layout of the coverage area.

Document RF systems already in use, location of host systems, available
AC power, possible antenna locations, interfering metal fire breaks and
wall structures, doorways and passages that could help RF propagation,
and amount of stock in coverage areas. For a warehouse, document
how high the stock is kept and how high the lifts go so that the lifts do
not damage the access points.

Set up an access point at one side of the proposed coverage area.
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4. Walk the perimeter and measure radio coverage.

If there are multiple floors, measure each floor separately. For an 11
Mbit direct-sequence network, document round-trip times and data
rates. The individual round-trip ping time is usually about 7 ms before
the rate changes from 11 Mbits to 5.5 Mbits (using a packet size of 1024
bytes). Move the terminal in different directions. Position the terminal
between the surveyor and the access point. Do not walk fast or a radio
coverage dead spot might be missed.

5. Document the boundry of each coverage area as the data rates could be
different in aeach area.

The access point could only be moved a few feet to result in better
coverage. For 11 Mbit high data rate networks, reflection is more of a
problem (ceiling sprinklers can cause a problem if the access point
antenna is less than 2 feet away). For a FH network, run 100 pings with
a packet size of 512 bytes. Total test time for 1T Mbit should be less than
13 seconds; 12 seconds for 2 Mbit.

6. Mark the location of each access point on the blueprint and move the
access point to different trial location.

Continue the process until the entire site has radio coverage.

7. Take a picture of at least one access point location for each coverage
are.

If each coverage area has unique features, take a picture of each. Take
pictures of racks, stock level, hub locations and racks. The pictures go
into the report and help establish the condition of the site as it was
surveyed.

8. Consult with customer technical personnel and document any additional
hubs that could be required (14 or more access points could require
multiple hubs).

Consider exact conditions that exist in the final installation.
9. Complete the Site Survey Report.

The report indicates the number and location of the access points. Assign
the access points the same channel for each coverage area.
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3.3 Conducting a Survey for a Large Area

To conduct a survey in a site where 20 - 100 access points are anticipated:

1.

Consult with the designated customer contact person.

Discuss any special installation requirements. Determine the type of
cables to be connected to the access points (10 Base T, 10 Base 2, fiber
optic).

Document the size and layout of the coverage area.

Document RF systems already in use, location of host systems, available
AC power, possible antenna locations, interfering metal fire breaks and
wall structures, doorways and passages that could help RF propagation,
and amount of stock in coverage areas. For a warehouse, document
how high the stock is kept and how high the lifts go so that the lifts do
not damage the access points.

Set up an access point at one side of the proposed coverage area.
Walk the perimeter and measure radio coverage.

If there are multiple floors, measure each floor separately. For an 11
Mbit direct-sequence network, document round-trip times and data
rates. The individual round-trip ping time is usually about 7 ms before
the rate changes from 11 Mbits to 5.5 Mbits (using a packet size of 1024
bytes). Move the terminal in different directions. Position the terminal
between the surveyor and the access point. Do not walk fast or a radio
coverage dead spot might be missed.

Document the boundary of each coverage area as the data rates could
be different in each area.

The access point could only be moved a few feet to result in better
coverage. For 11 Mbit high data rate networks, reflection is more of a
problem (ceiling sprinklers can cause a problem if the access point
antenna is less than 2 feet away). For a FH network, run 100 pings with
a packet size of 512 bytes. Total test time for 1 Mbit should be less than
13 seconds; 12 seconds for 2 Mbit.
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& Site survey boundary areas for multiple buildings should also be considered
e for large surveys. Determine if a LAN bridge and or wireless access points
are required.

6. Mark the location of each access point on the blueprint and move the
access point to different trial location.

Continue the process until the entire site has radio coverage.

7. Take a picture of at least one access point location for each coverage
are.

If each coverage area has unique features, take a picture of each. Take
pictures of racks, stock level, hub locations and racks. The pictures go
into the report and help establish the condition of the site as it was
surveyed.

8. Consult with customer technical personnel and document any additional
hubs that could be required (14 or more access points could require
multiple hubs).

Consider exact conditions that exist in the final installation.
9. Complete the Site Survey Report.

The report indicates the number and location of the access points. Assign
the access points the same channel for each coverage area.
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Appendix A

Intel® PRO/Wireless 2011 LAN Overview

For applications where mobility and real-time wireless communications are
essential, Intel® PRO/Wireless 2011 LAN provides high throughput,
expandable capacity, straightforward installation and superior interface
simplicity. Intel® PRO/Wireless 2011 LAN support for the IEEE 802.11
standard for wireless LANs safeguards a wireless LAN investment by ensuring
flexibility and broad industry support.

The Intel Site Survey utility uses direct-sequence (DS) and frequency-hopping
(FS) technology.
Intel® PRO/Wireless 2011 LAN infrastructure products include:

* bridging architecture to provide communication between radio and
wired multiple network segments

* adesign based on the IEEE 802.11 standard

*  roaming for mobile users with devices such as laptops, wireless
computers, scanning terminals and other computers with PCMCIA slots.
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A.1 Radio Basics

Intel® PRO/Wireless 2011 LAN devices use both electromagnetic waves and
radio signals to transmit and receive electric signals without wires. Users
communicate with the network by establishing radio links between terminals
and APs.

Intel® PRO/Wireless 2011 LAN uses FM (frequency modulation) to transmit
digital data from one device to another. Using FM, a radio signal begins with
a carrier signal that provides the base or center frequency. The digital data
signal is superimposed on the carrier signal (modulation). The radio signal
propagates into the air as eleciromagnetic waves. A receiving antenna

in the path of the waves absorbs the waves as electrical signals.

The receiving device demodulates the signal by removing the carrier signal.
This demodulation results in the original digital data.

Intel® PRO/Wireless 2011 LAN uses the environment (the air and certain
obijects) as the transmission medium. Intel® PRO/Wireless 2011 LAN radio
devices transmit in the 2.4 to 2.5-GHz frequency range, a license-free range
throughout most of the world. The actual range is country-dependent.

Intel® PRO/Wireless 2011 LAN devices, like other Ethernet devices, have
unique, hardware-encoded Media Access Confrol (MAC) or IEEE addresses.
MAC addresses determine the device sending or receiving data. A MAC
address is a 48-bit number written as six hexadecimal bytes separated by
colons. For example:

00 :A0:F8:24:9A:C8

To locate the AP MAC address see the bottom of the unit.

A.1.1 Network Topology

The possible network topologies depend on the following factors:
¢ the AP function in the network

¢ the data transfer rate.

A-2
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Select from the following topologies:

* Asingle access point used without the wired network provides a single-
cell wireless network for peer-to-peer MUs.

* Asingle access point can bridge the Ethernet and radio networks.
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*  Multiple access points can coexist as separate, individual networks at the
same site without interference using different Net_IDs.

|

fﬂw

I \
L

*  Multiple access points wired together provide a network with better
coverage area and performance.

A.1.2 Cellular Coverage

The access point establishes an average communication range with MUs
called a Basic Service Set (BSS) or cell. When in a particular cell the MU
associates and communicates with the access point of that cell. Each cell has
a Basic Service Set Identifier (BSS_ID). In 802.11, the access point MAC
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address represents the BSS_ID. The MU recognizes the access point it
associates with using the BSS_ID. Adding access points to a LAN establishes
more cells in an environment, making it an RF Network using the same

Net _ID or Extended Service Set (ESS).

Access points with the same Net_ID (ESS) define a coverage area. The MU
searches for access points with a matching Net ID (ESS) and synchronizes
with an access point to establish communications. This allows MUs within
the coverage area to move about or roam. As the MU roams from cell to cell,
it switches access points. The switch occurs when the MU analyzes the
reception quality at a location and decides which access point to
communicate with based on the best signal strength and lowest MU

load distribution.

If the MU does not find an access point with an acceptable signal, it performs
a scan to find any access point. As MUs switch access points, the access
point updates the association table. Roaming is invisible to the user in high-
level applications.
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A.2 Access Point (AP)

The Access Point (AP) provides a bridge between Ethernet wired LANs and
Intel® PRO/Wireless 2011 LAN. It provides connectivity between Ethernet
wired networks and radio-equipped mobile units (MUs). MUs include the full
line of Intel terminals, PC Cards and PCl adapters, scanners, third-party
devices and other devices.

The access point monitors Ethernet traffic and forwards appropriate Ethernet
messages to MUs over the network. It also monitors MU radio traffic and
forwards MU packets to the Ethernet LAN.

The access point meets:

* the regulatory requirements for Europe and many other areas of
the world

e FCC part 15, class A with no external shielding
e FCC part 15 class B, ETS 300-339 compliance, including CE mark.

An MU communicating with an access point appears on the network as a
peer to other network devices. The access point receives data from its wired
interfaces and forwards the data to the proper interface.

The access point has connections for the wired network, external antennas
and a power supply. The access point attaches to a wall or ceiling depending
on installation-site requirements.

The access point requires a single antenna for radio transmission and
reception. The dual-antenna system option allows the access point to select
the best radio signal.
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A.3 Advanced Radio Theory

To improve access point management and performance, users need to
understand basic access point functionality and configuration options.
The access point includes features for different interface connections and
network management.

The access point provides MAC layer bridging between its interfaces. The
access point monitors traffic from its interfaces and, based on frame address,
forwards the frames to the proper destination. The access point tracks the
frames sources and destinations to provide intelligent bridging as MUs roam
or network topologies change. The access point also manages broadcast
and multicast message initiations and responds to MU association requests.
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A.3.1 MAC Layer Bridging

[RE1

The AP listens to all packets on all interfaces and builds an address database
using the unique IEEE 48-bit address (MAC address). An address in the
database includes the interface media that the device uses to associates with
the access point. The access point uses the database to forward packets from
one interface to another. The bridge forwards packets addressed to unknown
systems to the Default Interface (either Ethernet or PPP). Users can use the
Ethernet interface as a wireless access point interface.

Wireless
AP

Wireless
AP

Wireless
AP

Wireless
AP

o
~ Database
-

AP
Internal ] AP Bridging Algorithm
Stack

Ethernet

The access point internal stack interface manages all messages directed to
the access point.

Each access point stores information on destinations and their interfaces to
facilitate forwarding. When a user sends an ARP (Address Resolution
Protocol) request packet, the access point forwards it over all enabled
interfaces (Ethernet, PPP and radio) except over the interface the ARP request
packet was received. On receiving the ARP response packet, the access point
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database keeps a record of the destination address along with the receiving
interface. With this information, the access point forwards any directed
packet to the correct destination. The access point forwards packets for
unknown destinations to the Ethernet interface.

& ARP request packets received over radio echo back to other access points
Fczhe over radio.

The access point removes from its database destinations or interfaces not
used for a specified time. The access point refreshes its database when it
transmits or receives data from these destinations and interfaces.

A.3.1.1 Filtering and Access Control

The access point provides facilities to limit the MUs that associate with it and
the data packets that can forward through it. Filters provide network security
and improve performance by eliminating broadcast/multicast packets from
the radio network.

The ACL (Access Control List) contains MAC addresses for MUs allowed to
associate with the access point. This provides security by preventing
unauthorized access.

The access point uses a disallowed address list of destinations. This feature
prevents the access point from communicating with specified destinations.
This can include network devices that do not require communication with the
access point or its MUs.

Depending on the setting, the access point can keep a list of frame types that
it forwards or discards. The Type Filtering option prevents specific frames
(indicated by the 16-bit DIX Ethernet Type field) from being processed by the
access point. These include certain broadcast frames from devices
unimportant to the wireless LAN, but take up bandwidth. Filtering out
unnecessary frames can improve performance.
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A.3.2 DHCP Support

The access point uses Dynamic Host Configuration Protocol (DHCP) to obtain
a leased IP address and network configuration information from a remote
server. DHCP is based on BOOTP protocol. DHCP can coexist or interoperate
with BOOTP. An access point sends out a DHCP request searching for a
DHCP server to acquire the network configuration and firmware filenames.
Because BOOTP and DHCP interoperate, the one that responds first
becomes the server that allocates information. The DHCP client automatically
sends a DHCP request every XX hours/days to renew the IP address lease as
long as the access point is running. (This parameter is programmed at the
DHCP server. Example: Windows NT servers typically are set for 3 days.)

The access point can download two files when a boot takes place, the
firmware file and an HTML file, since firmware version 1.00 and above
supports Web servers. Users can program the DHCP or BOOTP server to
transfer these two files when a DHCP request is made.

When the access point receives a network configuration change or is not
able to renew the IP address lease the access point sends out an SNMP trap.
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A.3.3 Media Types

The access point supports bridging between Ethernet, radio and
serial media.

The Ethernet interface fully complies with Ethernet Rev. 2 and IEEE 802.3
specifications. The access point supports 10Base-T wired connections and
full-speed filtering. The data transfer rate over radio waves is 11 Mbps.
The Ethernet interface is optional for single-cell or PPP-connected networks.

The radio interface conforms to IEEE 802.11 specifications. The interface
operates at 11 Mbps using direct-sequence radio technology. The access
point supports multiple-cell operations with fast, transparent roaming
between cells. With the direct-sequence system, each cell operates
independently. Each cell provides an 11 Mbps bandwidth. Adding cells to the
network increases coverage area and total system capacity. The access point
supports MUs operating in Power Save Polling (PSP) mode or Continuously
Aware Mode (CAM) without user intervention.

The DB-9, 9-pin, RS-232 serial port provides a Ul (User Interface) or a PPP
(Point to Point Protocol) connection. The Ul provides basic management tools
for the access point. The PPP provides a link between APs using a serial
connection. The serial link supports short haul (direct serial) or long haul
(telephone-line) connections. The access point is a DTE (Data Terminal
Equipment) device with male pin connectors for the RS-232 port. Connecting
the access point o a computer requires a null modem cable and connecting
the access point to a modem requires a straight-through cable.
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A.3.4 Bridging Support

The access point PPP (Point to Point Protocol) interface, accessible from
the serial port at the rear of the access point, provides two types of
bridging operations:

Ethernet

Data-link bridging between two access points. A network using a data-
link bridge provides radio coverage by using a remote access point in a
location geographically distant from the access point connected to the
Ethernet network. The remote access point cannot provide an Ethernet
connection to other access points. MUs associating with the remote

access point transmit and receive from the Ethernet network via the
PPP link.

= : =
—— Modem PP Link _ [ Modem 1-{ . )

i W —
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* Internet Protocol bridging between an access point and a computer.
To establish an Internet Protocol bridge with an access point, ensure the
computer includes the appropriate Telnet software with PPP and TCP/IP
protocols. Using Telnet, a remote computer can connect to any access
point on an Ethernet network, as long as data transfers through
IP packets.

Ethernet

A PPP link provides the option of using a direct serial link or modem to
extend wired Ethernet topologies.

Once in PPP mode, the access point automatically attempts to communicate

with the other device using the Data-Link Bridging (DLB) protocol. An access

point using DLB communicates on the MAC level, and receives and transmits
Ethernet frames.

If the other device does not support DLB, the access point attempts to
communicate using Infernet Protocol Control Protocol (IPCP). An access point
using IPCP communicates on the IP level, and receives and transmits IP
(Internet Protocol) packets.
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ot

The PPP implementation in the access point uses the Link Control Protocol
(LCP) and Network Control Protocol (NCP) as described in:

e RFC 1171: the Point-to-Point Protocol, July 1990

e RFC 1220: PPP Extensions for Bridging, April 1991

e RFC 1332: The PPP Internet Protocol Control Protocol, May 1992
* RFC 1661: The Point-to-Point Protocol, July 1994.

RFCs are Requests For Comments used in Internet Communities.

The access point database dynamically tracks MUs and access points on the
PPP interface. The access point forwards packets to the PPP link after
determining their destination.

The PPP implementation in the access point uses the NCP as described in
RFC 1220: PPP Extensions for Bridging to encapsulate packets at the Ethernet
level. The PPP provides IP bridging control as defined by RFC 1172 and
MAC-level bridging. It provides support for PPP negotiations conforming to
RFC 1661. Users cannot plug a non-AP node directly into the access point
serial port, only AP-to-AP PPP links.

Refer to RFC 1171: The Point to Point Protocol and RFC 1220: PPP Extensions
for Bridging for information.
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A.3.4.1 PPP Connection

Connecting two access points with a direct serial link requires a null-modem

serial cable.
AP (DTE) AP (DTE)
DB-9 (Female) DB-9 (Female)
2
3

AN O N W

—
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Connecting two access points with modem devices requires straight-through
cables between the access points and modems. Using modems requires a
telephone line for as long as the link remains active.

AP (DTE) Modem (DCE)
DB-9 (Female) DB-25 (Male)

’LO 0o N o0l dhwwN 4‘
N N
’N U O NS NW oo‘

When using a modem connection, one access point represents the
originating access point and the other represents the answering access point.
When using a PPP link, do not use the serial port to access the Ul. Access to
the Ul requires establishing a Telnet session with the access point.
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A.3.5 Direct-Sequence Spread Spectrum

Spread spectrum (broadband) uses a narrowband signal to spread the
transmission over a segment of the radio frequency band or spectrum.
Direct-sequence is a spread spectrum technique where the transmitted
signal is spread over a particular frequency range. The Intel® PRO/Wireless
2011 LAN Access Point uses direct-sequence spread spectrum (DSSS) for
radio communication.

Direct-sequence systems communicate by continuously transmitting a
redundant pattern of bits called a chipping sequence. Each bit of transmitted
data is mapped into chips by the access point and rearranged into a
pseudorandom spreading code to form the chipping sequence. The chipping
sequence is combined with a transmitted data stream to produce the access
point output signal.

Direct Sequence

Je——— 2.4 GhzBand ————]

=
&3

TEITT TR Chond

XCR <> 10011101011101

ﬁ Data Stream

Chipping Sequence Only 3 non~overlapping Channels
of Direct Sequence informotion
fit info defined 2.4 Ghs bond

Mobile units receiving a direct-sequence transmission use the spreading

code to map the chips within the chipping sequence back into bits to recreate
the original data transmitted by the access point. Intercepting and decoding
a direct-sequence transmission requires a predefined algorithm to associate
the spreading code used by the transmitting access point to the receiving MU.
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This algorithm is established when the access point and MU are configured.
The bit redundancy within the chipping sequence enables the receiving MU
to recreate the original data pattern, even if bits in the chipping sequence are
corrupted by interference.

The ratio of chips per bit is called the spreading ratio. A high spreading ratio
increases the resistance of the signal to interference. A low spreading ratio
increases the bandwidth available to the user. The access point uses two
chips per bit among three channels within the 2.4 GHz band in a pattern
avoiding any 1 or 2 Mbps systems operating in the same area. The access
point is capable of an 11 Mbps data transmission rate, but the coverage
area is less than a 1 or 2 Mbps access point since coverage area decreases
as bandwidth increases.

A.3.6 Frequency-Hopping Spread Spectrum

Frequency Hopping Spread Spectrum (FHSS) spreads radio signals by
transmitting a short burst on one frequency, jumping to another frequency
for another short burst and so on. Intel® PRO/Wireless 2011 LAN uses the
2.4 - 2.5 GHz range depending on the country, this range does not require
licensing from the FCC. FHSS offers a higher transmission rate than a
conventional radio narrowband method.

In FHSS systems, the carrier frequency of the transmitter changes (or hops) in
accordance with the pseudo-random code sequence. The code sequence
dictates the frequency order selected by the transmitter. The transmitter takes
the input data and spreads it in a predefined method. Each receiver has to
understand this predefined method and reconstruct the signal before
interpreting data. Stations in a cell using FHSS techniques hop or change the
carrier frequency at synchronized intervals. Government regulatory agencies
and standards, such as ETSI, MKK, the FCC and IEEE 802.11, determine the
number of frequency hops (79 for the U.S.), the hopping pattern (sequence
each frequency is used) and dwell fime (time at each frequency). The FCC
requires 75 or more hopping frequencies used and a maximum of 400ms
for dwell time per frequency. The transmitter and receiver synchronize to the
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hop sequence to ensure communication. The time synchronization field
included in message packets coordinates the hop timing of all units.

The user can program the length each hop lasts. Each hop is a frequency at
least 6 MHz away from the previous frequency and has a 1 MHz bandwidth.

FHSS can survive in an adverse environment and coexist with other devices/
services in the same band. The average signal strength being relatively low
on any given frequency is a result of FHSS. When the signal intelligence is
spread out over several MHz in the frequency spectrum, the resulting power
spectrum also spreads out (less than 1 watt). This results in the transmitted
power spread out over a wide frequency bandwidth and makes detection
very difficult (with out the code sequence).

Hopping provides enhanced data reception in the presence of interfering
signals, like fixed frequency radio networks or microwave ovens. The system
also resists interference because it spends a short time on each given
frequency. If an interfering source is present (interference at a specific
frequency), only a small number of frequency hops are blocked instead of
the entire range. With interference occurring on one frequency, the data is
retransmitted on a subsequent hop at another frequency. Even if constant
interference exists on a given frequency, it affects the radio network for only a
short time on that specific frequency. Although access points can share the
same hopping sequence, they usually do not synchronize in time. Rarely do
they simultaneously arrive at the same frequency, referred to as contention.
Interfering signals can reduce overall throughput at some frequencies. This
reduces the probability and impact of overlapping frequencies or collisions.
Although devices can hop to the same frequency, they eventually hop to
different frequencies after the hop time.

With Intel® PRO/Wireless 2011 LAN, each access point on the local network
negotiates a different hopping sequence at start-up. This allows access points
to provide frequency separation and evenly divide the frequency spectrum
among the units.
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A.3.7 MU Association Process

Access points recognize MUs as they associate with the access point. The
access point keeps a list of the MUs it services. MUs associate with an access
point based on the following conditions:

* the signal strength between the access point and MU
* the MUs currently associated with the access point

* the MU Supported Rate (see table below).

Data Rate Requirement
11 Mbps Optional
5.5 Mbps Optional
2 Mbps Optional
1 Mbps Required

MUs perform preemptive roaming by intermittently scanning for access
points and associating with the best available access point. Before roaming
and associating with access points, MUs perform full or partial scans to
collect access point statistics and determine the direct-sequence channel used
by the access point.

Scanning is a periodic process where the MU sends out probe messages on
all frequencies defined by the country code. The statistics enable an MU to
reassociate by synchronizing its frequency to the access point. The MU
continues communicating with that access point until it needs to roam
between cells.

MUs perform full scans at start-up. In a full scan, an MU uses a sequential set
of channels as the scan range. For each channel in range, the MU tests for
CCA (Clear Channel Assessment). When a transmission-free channel
becomes available, the MU broadcasts a probe with the Net_ID and the
broadcast BSS_ID. An AP-directed probe response generates an MU ACK
(Mobile Unit Acknowledgment) and the addition of the access point to the
access point table with a proximity classification. An unsuccessful access
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point packet transmission generates another MU probe on the same
channel. If the MU fails to receive a response within the time limit, it repeats
the probe on the next channel in the sequence. This process continues
through all channels in the range.

MUs perform partial scans at programmed intervals, when missing expected
beacons or after excessive transmission retries. In a partial scan, the MU
scans access points classified as proximate on the access point table. For
each channel, the MU tests for CCA. The MU broadcasts a probe with the
Net_ID and broadcast BSS_ID when the channel is fransmission-free. It sends
an ACK to a directed probe response from the access point, and updates the
access point table. An unsuccessful access point packet transmission causes
the MU to broadcast another probe on the same channel. The MU classifies
an access point as out-of-range in the access point table if it fails to receive a
probe response within the time limits. This process continues through all
access points classified as proximate on the access point table.

An MU can roam within the coverage area by switching access points.
Roaming is transparent and virtually instantaneous in high-level applications.
Roaming occurs when:

* an unassociated MU attempts to associate or reassociate with an
available access point

¢ the supported rate changes or the MU finds a better transmit rate with
another access point

* the RSS! (received signal strength indicator) of a potential access point
exceeds the current access point

¢ the ratio of good-transmitted packets to attempted-transmitted packets
falls below a threshold

e the MU detects an imbalance in the number of MUs associated with
available access points and roams to a less loaded access point.
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An MU selects the best available access point and adjusts itself to the access
point direct-sequence channel to begin association. Once associated, the
access point begins forwarding any frames it receives addressed to the MU.
Each frame contains fields for the current direct-sequence channel. The MU
uses these fields to resynchronize to the access point.

A.3.8 Mobile IP

The Internet Protocol identifies the MU point of attachment to a network
through its IP address. The access point routes packets according to the
location information contained in the IP header. If the MU roams across
routers to another subnet, the following situations occur:

¢ The MU changes its point of attachment without changing its IP address,
causing forthcoming packets to become undeliverable.

*  The MU changes its IP address when it moves to a new network, causing
it to lose connection.

Mobile IP enables an MU to communicate with other hosts using
only its home IP address after changing its point-of-attachment to the
internet/intranet.

Mobile IP is like giving an individual a local post office forwarding address
when leaving home for an extended period. When mail arrives for the
individual home address, it is forwarded by the local post office to the current
care-of-address. Using this method, only the local post office requires
notification of the individual current address. While this example represents
the general concept of Mobile IP operation and functionality, it does not
represent the implementation of Mobile IP used.

Atunnel is the path taken by the original packet encapsulated within the
payload portion of a second packet to some destination on the network.

A Home Agent is an access point acting as a router on the MU home
network. The home agent intercepts packets sent to the MU home address
and tunnels the message to the MU at its current location. This happens as
long as the MU keeps its home agent informed of its current location on
some foreign link.
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A Foreign Agent is an access point acting as a router at the MU location on a
foreign link. The foreign agent serves as the default router for packets sent
out by the MU connected on the same foreign link.

A care-of-address is the IP address used by the MU visiting a foreign link.
This address changes each time the MU moves to another foreign link. It can
also be viewed as an exit point of a tunnel between the MU home agent and
the MU itself.

The Mobile IP (roaming across routers) feature enables an MU on
the Internet to move from one subnet to another while keeping its IP
address unchanged.

& To configure Mobile IP, see the Product Reference Guide included with the

[ access point.

The scanning and associating process continues for active MUs. This allows
the MUs to find new access points and discard out-of-range or deactivated

access points. By testing the airwaves, the MUs can choose the best network
connection available.

The following diagram illustrates Mobile IP (roaming across routers):

Mobile Node Mobile Node
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& Set the MU for Mobile IP as specified in the MU user documentation.

Security has become a concern to mobile users. Enabling the Mobile-Home
MD5 key option in the System Configuration menu generates a 16-byte
checksum authenticator using an MD5 algorithm. The MU and access point
share the checksum, called a key, to authenticate transmitted messages
between them. The access point and MU share the key while the MU is
visiting a foreign subnet. The MU and AP have to use the same key. If not, the
access point refuses to become the Home Agent for the MU. The maximum
key length is 13 characters. The access point allows all printable characters.

A.3.9 Supporting CAM and PSP Stations

CAM (Continuously Aware Mode) stations leave their radios on continuously
to hear every beacon and message transmitted. These systems operate
without any adjustments by the access point. A beacon is a uniframe system
packet broadcast by the access point to keep the network synchronized. A
beacon includes the Net_ID (ESS), the access point address, the Broadcast
destination addresses, a time stamp, a DTIM (Delivery Traffic Indicator Maps)
and the TIM (Traffic Indicator Message).

PSP (Power Save Polling) stations power off their radios for long periods.
When a MU in PSP mode associates with an access point, it notifies the
access point of its activity status. The access point responds by buffering
packets received for the MU. The adapters use a PSP performance index
from1 to 5, where 1 provides the quickest response time and 5 provides the
most efficient power consumption.

The performance index determines how long the adapter stays in CAM after
transmit or receive activity. Regardless of the performance index used,
adapters switch to CAM for data reception/transmission. The awake interval
in PSP performance index 1 is long enough to allow for round-trip packet
response times. The packet response time in PSP performance index 5 is only
25 msec, the adapter goes back to sleep and requires another wake up
period to receive data.
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When the MU wakes up and sees its bit set in the TIM, it issues a short frame
to the access point for the packets stored. The access point sends them to the
MU and the MU issues another short frame when the data has been received
and is ready to go back to PSP. A DTIM field, also called a countdown field,
informs MUs of the next window for listening to broadcast and multicast
messages. When the access point has buffered broadcast or multicast
messages for associated MUs, it sends the next DTIM with a DTIM Interval
value. To prevent a PSP-mode MU from sleeping through a DTIM notification,
select a PSP mode value less than or equal to the DTIM value. PSP-mode
MUs hear the beacons and awaken to receive the broadcast and

multicast messages.

A TIM is a compressed virtual bitmap identifying the access point associated
MUs in PSP mode that have buffered directed messages. MUs issue a poll
request when access points issue a TIM. A beacon with the broadcast-
indicator bit set causes the MU to note DTIM Count field value. The value
informs the MU of the beacons remaining before next DTIM. This ensures
the MU turns on the receiver for the DTIM and the following BC/MC

packet transmissions.
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A.3.10 Data Encryption

Intel® PRO/Wireless 2011 LAN devices operating on a wired or wireless
network face possible information theft. This occurs when an unauthorized
user eavesdrops on someone else to obtain information illegally. The
absence of a physical connection makes wireless links particularly vulnerable
to this form of theft. Encryption becomes the most efficient method in
preventing information theft and improving data security. Encryption entails
scrambling and coding information, typically with mathematical formulas
called algorithms, before the information is transmitted over a network. An
algorithm is a set of instructions or formula for scrambling the data. A key is
the specific code used by the algorithm to encrypt or decrypt the data.
Decryption is the decoding and unscrambling of received encrypted data.
The same device, host computer or front-end processor, usually performs
both encryption and decryption. The data transmit or receive direction
determines whether the encryption or decryption function is performed. This
device takes the plain text and scrambles or encrypts it and transmitting the
data over the network, typically by mathematically combining the key with
the plain text as prescribed by the algorithm. At the receiving end another
device takes the encrypted text and decrypts, unscrambles, the text resulting
in the original plain text. An authorized user can know the algorithm, but
cannot interpret the encrypted data without the appropriate key. Only the
sender and receiver of the transmitted data know the key.

Intel uses the Wired Equivalent Privacy (WEP) algorithm, specified in IEEE
802.11 section 8, for encryption and decryption. WEP uses the same key for
both encrypting and decrypting plain text. Typically an external key
management service distributes the key. Users should change the key often
for added security. By default, IEEE 802.11 devices operate in an open
system network where any wireless device can associate with an access point
without authorization. A wireless device with a valid Encryption key is allowed
to associate with the access point. Authentication management messages
(packets) are unicast, meaning authentication messages transmit from one
access point to one MU only, not broadcast or multicast.
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A.3.11 HTTP HTML Web Server Support

Hypertext Transfer Protocol (HTTP) is the native language of the Web.

The HTTP protocol makes requests from browsers (the user) to servers and
responses from servers to browsers. This function provides the user with a
Web-based format for configuration and firmware download.

Web pages are written in HTML (Hypertext Markup Language.) HTML allows
the user to create web pages containing text, graphics and pointers or links
to other web pages or elsewhere on the page or document. Pointers are
known as Uniform Resource Locators (URLs). A URL is essentially the name of
the web page. The URL consists of three parts:

* the protocol (a scheme)

* the DNS (Domain Name Server) the machine where the page is located
* the local name that identifies the page (usually the file name).

The HTML language describes how to format the document. Much like a

copyeditor describes which fonts to use, such as the location, color, header
size and text.

A-26
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A.3.12 Management Options

Managing an Intel® PRO/Wireless 2011 LAN includes viewing network
statistics and setting configuration options. Statistics track the network activity
of associated MUs and data transfers on the access point interfaces.
Configuration involves setting system operating parameters and filters used
in bridging.

The access point requires one of the following to perform a custom
installation or maintain the Intel® PRO/Wireless 2011 LAN:

*  SNMP (Simple Network Management Protocol)

* wired LAN workstation with a Telnet client

* terminal or PC with RS-232 connection and ANSI emulation

Changing one access point does not affect the configuration of other access

points on the network. Make configuration changes to access points
individually. Each access point requires an individual IP address.
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A.3.12.1 Programmable SNMP Trap Support

The SNMP defines the method for obtaining information about networks
operating characteristics and changing router and gateway parameters.
SNMP consists of three elements:

* management stations
* management information

* o management protocol.

Nodes can perform as hosts, routers, bridges or other devices that can
communicate status information. An SNMP Agent is a node that runs the
SNMP management process to systematically monitor and manage the
network. The management station performs network management by
running application management software.

An SNMP trap is an alert to all configured management stations of some
significant event that occurred on the network. The management station
queries all stations for details of each specific event, including what, when
and where the event took place and the current status of the node or
network. The format or structure is defined in SNMP. The MIB defines what
and who monitors the variables.

A.3.12.2 Using SNMP

The access point includes SNMP agent versions accessible via an SNMP
manager application such as, HP Open View or Cabletron Spectrum MIB
browser. The SNMP agent supports SNMP versions 1 and 2, MIB Il, the
802.11 MIB and one Intel proprietary MIB (Management Information Base).
The SNMP agent supports read-write, read-only or disabled modes. The
access point supports traps that return to the SNMP manager when certain
events occur. The Wireless LAN Installation and Utilities disk packaged with
MUs contains the MIB.
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A.3.12.3 Increased MIB Support

The MIB defines what the management station needs to understand and
which objects the station manages. The MIB has ten categories defined with
approximately 175 variables.

A.3.12.4 Using the Ul

The Ul (User Interface) is a texi-based maintenance tool integrated into the
access point. It provides statistical displays, access point configuration
options and firmware upgrades. Access to the Ul requires one of

the following:

Telnet Client Gain access to the access point built-in Telnet server from
any access point interface including remote Ethernet
connections.

Direct Serial Acts as a DTE device to connect directly to a DTE device
Connection with a null-modem serial cable. The direct serial access
method requires a communication program with
ANSI| emulation.

Dial Up Access  The dial-up access method requires a communication
program with ANSI emulation on the remote terminal
or PC. The terminal or PC dials to an access point with a
modem connection. The access point supports connection
to a Hayes-compatible 28,800-baud or faster modem.

SNMP Via a MIB  Gain access to the access point SNMP function via a MIB

Browser Browser. Typically a Network Manager uses this feature,
Intel does not recommend access point access using this
interface method. Refer to the MIB Browser documentation
for usage.

Web Browser Gain access to the access point built-in Web server from
any access point interface including remote Ethernet
connections.

For instructions on adjusting the access point configuration options refer to
the Product Reference Guide included with the access point.
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Customer Support

B.1 Intel Automated Customer Support

You can reach Intel automated support services 24 hours a day, every day at
no charge. The services contain the most up-to-date information about Intel
products. You can access installation instructions, troubleshooting
information, and general product information.

User Guide on Your Product CDROM

For more information about installing drivers or troubleshooting other topics,
see the online User Guide. To view the guide, insert the Intel CD in your drive
and wait for the Autorun to display. Click the User Guide button to view the
guide. Note that a web browser is required to view the guide.

Web and Internet Sites
* Support: http://support.intel.com

*  Network Products: http://www.intel.com/network
e Corporate: http://www.intel.com

*  Newsgroups:news://cs.intel.com

*  FTP Host: download.intel.com

*  FTP Directory: /support/network/adapter/

Customer Support Technicians
US and Canada: 1-916-377-7000 (7:00 - 17:00 M-F Pacific Time)

Worldwide access: Intel has technical support centers worldwide. Many of the
centers are staffed by technicians who speak the local languages. For a list of
all Intel support centers, the telephone numbers, and the times they are
open, download document 9089 from one of the automated services.
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B.2 Software License Agreement

IMPORTANT - READ BEFORE COPYING, INSTALLING OR USING.

Do not use or load this software and any associated materials (collectively,
the "Software") until you have carefully read the following terms and
conditions. By loading or using the Software, you agree to the terms of this
Agreement. If you do not wish to so agree, do not install or use the Software.

LICENSE. You may copy the Software onto a single computer for your
personal, non-commercial use, and you may make one back-up copy of the
Software, subject to these conditions:

This Software is licensed for use only in conjunction with Intel component
products. Use of the Software in conjunction with non-Intel component
products is not licensed hereunder.

You may not copy, modify, rent, sell, distribute or transfer any part of the
Software except as provided in this Agreement, and you agree to prevent
unauthorized copying of the Software.

You may not reverse engineer, decompile, or disassemble the Software.

You may not sublicense or permit simultaneous use of the Software by more
than one user.

The Software may contain the software or other property of third party
suppliers, some of which may be identified in, and licensed in accordance
with, any enclosed "license.ixt" file or other text or file.

OWNERSHIP OF SOFTWARE AND COPYRIGHTS. Title to all copies of the
Software remains with Intel or its suppliers. The Software is copyrighted and
protected by the laws of the United States and other countries, and
international treaty provisions. You may not remove any copyright notices
from the Software. Intel may make changes to the Software, or to items
referenced therein, at any time without notice, but is not obligated to support
or update the Software. Except as otherwise expressly provided, Intel grants
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no express or implied right under Intel patents, copyrights, trademarks, or
other intellectual property rights. You may transfer the Software only if the
recipient agrees to be fully bound by these terms and if you retain no copies

of the Software.

LIMITED MEDIA WARRANTY. If the Software has been delivered by Intel on
physical media, Intel warrants the media to be free from material physical
defects for a period of ninety (90) days after delivery by Intel. If such a defect
is found, return the media to Intel for replacement or alternate delivery of the
Software as Intel may select.

EXCLUSION OF OTHER WARRANTIES. EXCEPT AS PROVIDED ABOVE, THE
SOFTWARE IS PROVIDED "AS IS" WITHOUT ANY EXPRESS OR IMPLIED
WARRANTY OF ANY KIND INCLUDING WARRANTIES OF
MERCHANTABILITY, NON-INFRINGEMENT, OR FITNESS FOR A PARTICULAR
PURPOSE.

Intel does not warrant or assume responsibility for the accuracy or
completeness of any information, text, graphics, links or other items
contained within the Software.

LIMITATION OF LIABILITY. IN NO EVENT SHALL INTEL OR ITS SUPPLIERS BE
LIABLE FOR ANY DAMAGES WHATSOEVER (INCLUDING, WITHOUT
LIMITATION, LOST PROFITS, BUSINESS INTERRUPTION, OR LOST
INFORMATION) ARISING OUT OF THE USE OF OR INABILITY TO USE THE
SOFTWARE, EVEN IF INTEL HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. SOME JURISDICTIONS PROHIBIT EXCLUSION OR
LIMITATION OF LIABILITY FOR IMPLIED WARRANTIES OR CONSEQUENTIAL
OR INCIDENTAL DAMAGES, SO THE ABOVE LIMITATION MAY NOT APPLY
TO YOU. YOU MAY ALSO HAVE OTHER LEGAL RIGHTS THAT VARY FROM
JURISDICTION TO JURISDICTION.

TERMINATION OF THIS AGREEMENT. Intel may terminate this Agreement at
any time if you violate its terms. Upon termination, you will immediately
destroy the Software or return all copies of the Software to Intel.
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APPLICABLE LAWS. Claims arising under this Agreement shall be governed
by the laws of California, excluding its principles of conflict of laws and the
United Nations Convention on Contracts for the Sale of Goods. You may not
export the Software in violation of applicable export laws and regulations.
Intel is not obligated under any other agreements unless they are in writing
and signed by an authorized representative of Intel.

GOVERNMENT RESTRICTED RIGHTS. The Software is provided with
"RESTRICTED RIGHTS." Use, duplication, or disclosure by the Government is
subject to restrictions as set forth in FAR52.227-14 and DFAR252.227-7013
et seq. or their successors. Use of the Software by the Government constitutes
acknowledgment of Intel's proprietary rights therein. Contractor or
Manufacturer is Intel Corporation, 2200 Mission College Blvd., Santa Clara,
CA 95052.
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B.3 Limited Lifetime Hardware Warranty

Intel warrants to the original owner that the adapter product delivered in this
package will be free from defects in material and workmanship. This
warranty does not cover the adapter product if it is damaged in the process
of being installed or improperly used.

THE ABOVE WARRANTY IS IN LIEU OF ANY OTHER WARRANTY, WHETHER
EXPRESS, IMPLIED OR STATUTORY, INCLUDING BUT NOT LIMITED TO ANY
WARRANTY OF NONINFRINGEMENT OF INTELLECTUAL PROPERTY,
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE ARISING OUT
OF ANY PROPOSAL, SPECIFICATION, OR SAMPLE.

This warranty does not cover replacement of adapter products damaged by
abuse, accident, misuse, neglect, alteration, repair, disaster, improper
installation, or improper testing. If the adapter product is found to be
defective, Intel, at its option, will replace or repair the hardware product at
no charge except as set forth below, or refund your purchase price provided
that you deliver the adapter product along with a Return Material
Authorization (RMA) number (see below), along with proof of purchase (if not
registered), either o the dealer from whom you purchased it or to Intel with
an explanation of any deficiency. If you ship the adapter product, you must
assume the risk of damage or loss in transit. You must use the original
container (or the equivalent) and pay the shipping charge.

Intel may replace or repair the adapter product with either new or
reconditioned parts, and any adapter product, or part thereof replaced by
Intel becomes Intel property. Repaired or replaced adapter products will be
returned to you at the same revision level as received or higher, at Intel's
option. Intel reserves the right to replace discontinued adapter products with
an equivalent current generation adapter product.
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Returning a defective product

From North America:

Before returning any adapter product, contact Intel Customer Support and
obtain a Return Material Authorization (RMA) number by calling +1 916-
377-7000.

If the Customer Support Group verifies that the adapter product is defective,
they will have the RMA department issue you an RMA number to place on the
outer package of the adapter product. Intel cannot accept any product
without an RMA number on the package.

All other locations:

Return the adapter product to the place of purchase for a refund or
replacement.

Intel Adapter Money-back Guarantee (North America Only)

Intel wants you to be completely satisfied with the Intel adapter product that
you have purchased. Any time within ninety (90) days of purchase, you may
return your Intel adapter to the original place of purchase for a full refund of
the purchase price from your dealer. Resellers and distributors, respectively,
accepting returns and refunding money back to their customers may return
Intel adapters to their original place of purchase. Intel guarantees that it will
accept returns under this policy and refund the original purchase price to
customers purchasing directly from Intel.
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Limitation of Liability and Remedies

INTEL'S SOLE LIABILITY HEREUNDER SHALL BE LIMITED TO DIRECT,
OBJECTIVELY MEASURABLE DAMAGES. IN NO EVENT SHALL INTEL HAVE
ANY LIABILITY FOR ANY INDIRECT OR SPECULATIVE DAMAGES
(INCLUDING, WITHOUT LIMITING THE FOREGOING, CONSEQUENTIAL,
INCIDENTAL, AND SPECIAL DAMAGES) INCLUDING, BUT NOT LIMITED
TO, INFRINGEMENT OF INTELLECTUAL PROPERTY, REPROCUREMENT
COSTS, LOSS OF USE, BUSINESS INTERRUPTIONS, LOSS OF GOODWILL,
AND LOSS OF PROFITS, WHETHER ANY SUCH DAMAGES ARISE OUT OF
CONTRACT NEGLIGENCE, TORT, OR UNDER ANY WARRANTY,
IRRESPECTIVE OF WHETHER INTEL HAS ADVANCE NOTICE OF THE
POSSIBILITY OF ANY SUCH DAMAGES. NOTWITHSTANDING THE
FOREGOING, INTEL'S TOTAL LIABILITY FOR ALL CLAIMS UNDER THIS
AGREEMENT SHALL NOT EXCEED THE PRICE PAID FOR THE PRODUCT.
THESE LIMITATIONS ON POTENTIAL LIABILITIES WERE AN ESSENTIAL
ELEMENT IN SETTING THE PRODUCT PRICE. INTEL NEITHER ASSUMES
NOR AUTHORIZES ANYONE TO ASSUME FOR IT ANY OTHER LIABILITIES.

Some states do not allow the exclusion or limitation of incidental or
consequential damages, so the above limitations may not apply to you.

Critical Control Applications: Intel specifically disclaims liability for use of the
adapter product in critical control applications (including, for example only,
safety or health care control systems, nuclear energy control systems, or air
or ground traffic control systems) by Licensee or Sublicensees, and such use
is entirely at the user's risk. Licensee agrees to defend, indemnify, and hold
Intel harmless from and against any and all claims arising out of use of the
adapter product in such applications by Licensee or Sublicensees.

Software: Software provided with the adapter product is not covered under
the hardware warranty described above. See the applicable software license
agreement which shipped with the adapter product for details on any
software warranty.
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Appendix C
Regulatory Compliance

To comply with U.S. and international regulatory requirements, the following
information has been included. The document applies to the complete line of
Intel products. Some of the labels shown, and statements applicable to other
devices might not apply to all products.

Radio Frequency Interference Requirements

This device has been tested and found to comply with the limits for a Class A
digital device pursuant to Part 15 of the Federal Communications
Commissions Rules and Regulation. These limits are designed to provide
reasonable protection against harmful interference when the equipment is
operated in a commercial environment. This equipment generates, uses, and
can radiate radio frequency energy and, if not installed and used in
accordance with the instruction manual, may cause harmful interference to
radio communications. Operation of this equipment in a residential area is
likely to cause harmful interference in which case the user will be required to
correct the interference at his own expense.

However, there is no guarantee that interference will not occur in a particular
installation. If the equipment does cause harmful interference to radio or
television reception, which can be determined by turning the equipment off
and on, the user is encouraged to try to correct the interference by one or
more of the following measures:

* Re-orient or relocate the receiving antenna.
* Increase the separation between the equipment and receiver.

*  Connect the equipment into an outlet on a circuit different from that
which the receiver is connected.

e Consult the dealer or an experienced radio/TV technician for help.
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Radio Frequency Interference Requirements - Canada

This Class A digital apparatus meets the requirements of the Canadian
Interference-Causing Equipment Regulations.

CE Marking & European Union Compliance

Products intended for sale within the European Union are marked with

<€ the CEMark which indicates compliance to applicable Directives and
European Normes (EN), as follows. Amendments to these Directives or
ENs are included: Normes (EN), as follows.

Applicable Directives:
* Electromagnetic Compatibility Directive 89/336/EEC

¢ Low Voltage Directive 73/23/EEC

Applicable Standards:
e EN 55022 - Limits and Methods of Measurement of Radio Interference
Characteristics of Information technology Equipment

e EN 50 082-1 - Electromagnetic Compatibility - Generic Immunity
Standard, Part 1: Residential, commercial, Light Industry

e |EC 801.2 - Electromagnetic Compatibility for Industrial Process
Measurement and Control Equipment Part 2: Electrostatic
Discharge Requirements

e |EC 801.3 - Electromagnetic Compatibility for Industrial Process
Measurement and Control Equipment Part 3: Radiated
Electromagnetic Field Requirements

e |EC 801.4 - Electromagnetic Compatibility for Industrial Process
Measurement and Control Equipment Part 4: Electrical Fast
Transients Requirements

e EN 60950 + Amd 1 + Amd 2 - Safety of Information Technology
Equipment Including Electrical Business Equipment

* EN 60 825-1 (EN 60 825) - Safety of Devices Containing Lasers
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RF Devices

Intel RF products are designed to be compliant with the rules and regulations
in the locations into which they are sold and will be labeled as required. The
majority of Intel’s RF devices are type approved and do not require the user
to obtain license or authorization before using the equipment. Any changes
or modifications to Intel equipment not expressly approved by Intel could
void the user’s authority to operate the equipment.

Telephone Devices (Modems)
United States

If this product contains an internal modem it is compliant with Part 68 of the
Federal Communications Commission Rules and Regulations and there will
be a label on the product showing the FCC ID Number and the REN, Ringer
Equivalence Number. The REN is used to determine the quantity of devices
which maybe connected to the telephone line. Excessive RENs on the
telephone line may result in the device not ringing in response to an
incoming call. In most but not all areas, the sum of the RENs should not
exceed 5.0. To be certain of the number of devices that may be connected to
the line, as determined by the total number of RENs, contact the telephone
company to determine the maximum REN for the calling area.

If the modem causes harm to the telephone network, the telephone company
will notify you in advance; however, if advance notice is not practical, you will
be notified as soon as possible. Also, you will be advised of your right to file
a complaint with the FCC if you believe it is necessary.

The telephone company may make changes in its facilities, equipment,
operations or procedures that could affect the operation of the modem. If
this happens the telephone company will provide advance notice so you may
make any necessary modifications to maintain uninterrupted service.
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Canada

If this product contains an internal modem it is compliant with CS-03 of
Industry Canada and there will be a Canadian certification number
(CANADA: _____ ) on a label on the outside of the product. This certification
means that the equipment meets certain telecommunications network
protective, operational and safety requirements. The Department does not
guarantee the equipment will operate to the user’s satisfaction.

Before installing this equipment, users should ensure that it is permissible to
be connected to the facilities of the local telecommunications company. The
equipment must also be installed using an acceptable method of connection.
In some cases, the company’s inside wiring associated with a single-line,
individual service maybe extended by means of a certified convector
assembly (telephone extension cord). The customer should be aware that
compliance with the above conditions may not prevent degradation of
service in some situations.

Repairs to certified equipment should be made by an authorized Canadian
maintenance facility designated by the supplier. Any repairs or alterations
made by the user to this equipment, or equipment malfunctions, may give
the telecommunications company cause to request the user to disconnect
the equipment.

User should ensure for their own protection that the electrical ground
connections of the power utility, telephone lines and internal metallic water
pipe system, if present, are connected together. This precaution may be
particularly important in rural areas.

User should not attempt to make such connections themselves, but should
contact the appropriate electric inspection authority, or electrician,

Caution as appropriate.
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The Load Number (LN) assigned to each terminal device denotes the
percentage of the total load to be connected to the telephone loop which is
used by the device, to prevent overloading. The termination of a loop may
consist of any combination of devices, subject only to the requirement that
the total of the Load Numbers of all devices not exceed 100.

The Load Number is located on a label on the product.

Si ce produit contient un intérieur modem duquel est conformité avec le code
CS-03 de l'industrie canadien alors il aura un numéro de la certification
canadienne (CANADA: ) sur 'étiquette afficheé au produit. L'étiquette
d'Industrie Canada a identifiée le matériel homologué. Cette étiquette a
certifiée que le matériel est conformé aux certaines normes de protection,
d'exploitation et de sécurité des réseaux de télécommunications. Toutefois, le
Ministére n'assure pas que le matériel fonctionnera & la satisfaction de
I'utilisateur.

Avant d'installer ce matériel, I'vtilisateur doit assurer qu'il soit permis de
raccorder aux installations de l'entreprise télécommunications locales. Le
matériel doit &tre également installé au suivant d'une méthode de
raccordement. Dans certains cas, les fils intérieurs de I'entreprises utilisés
pour un service individuel & la ligne unique peuvent étre prolongés au
moyen d'un dispositif de raccordement homologué (cordon rallongé
téléphonique interne). L'abonné ne doit pas oublier qu'il est possible que la
conformité aux conditions énoncées ci-dessus n'empéchent pas la
dégradation du service dans les certaines situations. Actuellement, les
entreprises de télécommunication ne permettent pas que l'on raccorde leur
matériels a des jacks d'abonnés, sauf dans les cas précis et prévus pas les
tarrifs particuliers de ces entreprises.

Les réparations de matériel homologué doivent étre effectuées par un centre
d'entretien canadien autorisé par le fournisseur. La compagnie de
télécommunications peut demander a |'utilisateur de débrancher un appareil
& la suite des réparations ou des modifications effectuées par I'utilisateur, ou
& cause des mauvais fonctionnement.
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Lauhan

Pour sa propre protection, I'utilisateur doit assurer que tous les fils de mise &
terre de la source d'énergie électrique, lignes téléphoniques et les
canalisations d'eau métalliques, s'il y en a, soient raccordés ensemble. Cette
précaution est particuliérement importante dans les regions rurales.

AVERTISSEMENT: L'utilisateur ne doit pas tenter de faire ces raccordements
lui-méme; il doit avoir recours aux services d' électronician.

L'indice de charge (IC) assigné & chaque dispositif terminal indique, pour
éviter toute surcharge, le pourcentage de la charge totale qui peut étre rac-
cordé au circuit téléphonique bouclé d' utiliser par ce dispositif. La
terminasion du circuit bouclé peut étre constituée de n'importe quelle
combinaison de dispositifs, pourvu que la somme des indices de charge
dans I'ensemble des dispositifs ne dépassent pas 100.

L'indice de charge se trouve sur le produit.

Laser Devices

Cauhon

Intel products using lasers comply with US 21CFR1040.10, Subchapter J and
IEC825/EN 60 825 (or IEC825-1/EN 60 825-1, depending on the date of
manufacture). The laser classification is marked one of the labels on the
product.

Class 1 Laser devices are not considered to be hazardous when used for
their intended purpose. The following statement is required to comply with
US and international regulations:

Use of controls, adjustments or performance of procedures other than
those specified herein may result in hazardous visible or invisible laser
light exposure.
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Class 2 laser scanners use a low power, visible light diode. As with any

very bright light source, such as the sun, the user should avoid staring directly
into the light beam. Momentary exposure to a Class 2 laser is not known to
be harmful.
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